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1 Introduction 

 
The BC Pension Extract Utility allows you to extract information from ComVida Payroll 
and create fixed width (.dat) files to be sent to The BC Pension Corporation for 
Employer Data Reporting. 
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2 Payroll Items 

There are four (4) items that are needed.  
 

 

 

 
If you are currently using items 6700, 6720 & 6730 for purposes 
other than 
this process.
If you are not sure of what numbers to use, please contact the 
Helpdesk for suggestions.
 

 

2.1 Employee Contribution Item (6700)
 
Main Tab 
 
If your company’s pension rates differ
main tab with the correct rate.
 

 

 

) items that are needed.   

If you are currently using items 6700, 6720 & 6730 for purposes 
other than MPP please change those item numbers before you begin 
this process. 
If you are not sure of what numbers to use, please contact the 
Helpdesk for suggestions. 

Employee Contribution Item (6700) 

If your company’s pension rates differ please update the Description (Desc) on the 
main tab with the correct rate. 
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If you are currently using items 6700, 6720 & 6730 for purposes 
MPP please change those item numbers before you begin 

If you are not sure of what numbers to use, please contact the 

update the Description (Desc) on the 
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Cheques & Slips Tab 
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Variables Tab 
 

 
If your company’s pension rates differ please update the SRT1 rate under Numbers 
(var 1) on the variables tab with the correct rate. 
 

 

 
 
 
To make sure this filter will work for your site 
 
Go to Setup | Codes | Items |  
 
Set a filter File | Filter | clear out the filter | key in a Y beside MPP. 
 
A list of items will be shown on the screen.  To print the list File | Print.  These items 
are the amounts that will be included in your Pension Earnings.    
 
Compare this list to a list of all your items.  If any item is missing or should not be 
on the list please contact the helpdesk.  
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Formula Tab 
 

 
  

The less than 

or equal 

symbol is  

ALT (hold the 

key down) 

numeric  key 

pad 162 
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2.2 Employee Contribution Item (6701) 
 
Main Tab 
 
If your company’s pension rates differ please update the Description (Desc) on the 
main tab with the correct rate. 
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Cheques & Slips Tab 
 

 



ComVida Corporation 
 

 
 
MPP Extract Setup.docxx Page 8 

Variables Tab 

 

If your company’s pension rates differ please update the SRT2 rate under Numbers 
(var 1) on the variables tab with the correct rate. 
 

 

 

 
If you have not checked the BASE in 6700 make sure you do so now. 
 
To make sure this filter will work for your site 
 
Go to Setup | Codes | Items |  
 
Set a filter File | Filter | clear out the filter | key in a Y beside MPP. 
 
A list of items will be shown on the screen.   
To print the list File | Print.  These items are the amounts that will be included in your 
Pension Earnings.    
 
Compare this list to a list of all your items.  If any item is missing or should not be 
on the list please contact the helpdesk.  



ComVida Corporation 
 

 
 
MPP Extract Setup.docxx Page 9 

Formula Tab 
 

  
 

The less than 

or equal 

symbol is  

ALT (hold the 

key down) 

numeric  key 

pad 149 
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2.3 Employer Portion (6720) 

 
Main Tab 
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Cheques & Slips Tab 
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Variables Tab 
 
If your company’s pension rates differ please update the SRATE rate under Numbers 
(var 1) on the variables tab with the correct rate. 
 

 
 
 
This is a new filter checking the hrs to be collected for the MPP year end pension 
report.    
 
Make sure all hours that are to be added into MPP are being included in this filter.    
 
To make sure this filter will work for your site 
 
Go to Setup | Codes | Items |  
 
Set the filter File | Filter | clear out the filter | key in a G in the 1st position; a Y beside 
8th position (MPP) and an ! in the 9th position. 
 
A list of items will be shown on the screen.  To print the list File | Print.  These are 
the MPP hours that will be included in your Pension report.    
 
Compare this list to a list of all your items.  If any item is missing or should not be 
on the list please contact the helpdesk.  
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Formula Tab 
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2.4 Month Counter (6730) 

 
Main Tab 
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Cheques & Slips 
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Variables Tab 
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Formula Tab 
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3 Reporting  

3.1 Employee Addresses and Bargaining Units (SUPER-AD) 

 
1. Start the ComVida Reports program. 

 
2. Select Add…, and “No” to “Copy current record?”  

 
3. Add the new report as shown:  
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 The Test Criteria above will only include employees who have made contributions to 
MPP  in #6700 for the current year.  If you’re printing the Addresses for employees who 
contributed last year then update the Value to AMLAYR. 
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Note: The names and addresses of all employees must be correctly formatted.   
• The name must be in the format of “BLACK, JANE.”, i.e. first name is after the last 

name, and separated by a comma. 
• City and province must be in the 2nd address line, and separated by a comma, e.g. 

“DELTA, BC”.  Use the two letter province code without any periods. 
• Postal code must be in the 3rd address line. 
• This report only needs to be sent to MPP when you first join.  This is a one-time 

export. All other address changes will be made on the MPP web site. 
 
 

 
 

2. Print the SUPER-AD report, and verify the information.  Update the employee’s 
information in Payroll and repeat this step if necessary. 

 
3. Export the SUPER-AD report. 

 
a) In the Reports program, Select SUPER-AD in the Report List. 
b) In the Process menu, select Export Reports…, and in the Process – Export Reports 

screen, select Current and press OK. 
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4. Go to the Tools menu in Payroll or Reports, and select BC Pension Extract.  Sign on with 
the Operator ID and Password used in Payroll or Reports. 

 
5. Import the SUPER-AD into the ComVida BC Pension Extract Utility program. 

 
In the Process menu, select Import | Addresses… 
 

 
 

• Enter the name of the file to be imported (e.g. SUPER-AD.LST) in Import File:  
You can also click on the Browse… button to select the Import file. 
 

• Enter/update your Employer Name, Number (Employer Organization ID), and T4 
Year. 
 

• Enter the Union Codes from Payroll, e.g. “H” and “N” and map each one to the 
appropriate Plan, Employee Group and Bargaining Unit.  Don’t forget to do 
mapping for those non-union employees (who may have a blank union code in 
Payroll) that have to be included in the BC Pension Extract Utility program. 

 
Tip:  To start over with a fresh import, you can respond Yes if prompted to “Erase 

existing records?”.   
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6. Verify the Detail List and make changes as required.  If any data corrections are necessary, 
update the data in Payroll and repeat steps 1 to 5, or make the modifications within the BC 
Pension Extract Utility program.   
 
Note: You may have to scroll to the right to see the information for the employees.  Not all 

of the information is shown on the Detail List, but when you double-click (or select 
Update) a row then all the information will be shown in the Detail – Update screen. 

 

 
 
7. Update the entries, if necessary, by selecting the line(s), and clicking Update… 
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Warning:   Any changes made in the BC Pension Extract Utility program will NOT 
be reflected in Payroll.  We recommend correcting the data in Payroll 
and repeating steps 1 to 6. 

 
8. Print the Details report and verify that the entries are correct.  

 
a) From the File menu, click Print… and make sure the Address List is selected in the 

Format section. 
b) Check the report.  If updates are required, refer to step 6 above for any necessary 

corrections. 
 

9. Export the data from BC Pension Extract Utility program. 
 
From the Process menu, select Export | Addresses… to get the Export – Addresses screen. 
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a) The export filename will default to MPP + Organization ID as entered in Number in 
the import, and it must have an extension of  “.DAT”.   

 
• Update the Employer Name: if necessary. 
 
• Update the Employer Number (or Employer Organization ID) as assigned by the 

BC Pension Corporation. 
 

A “BC PENSION CORPORATION CONTRIBUTOR ADDRESS & PLAN REPORT” 
will be printed, and you will see a prompt indicating “Export was successful!”. 
 
The entries will then be exported to the file specified above (e.g. MPP1752.DAT).  The BC 
Pension Extract Utility program will put the exported file into the Payroll data folder (i.e. 
\HR\PR1 or \HR\DATA). 

 
10. To submit the file, follow the instructions provided by BC Pension Corporation or your 

systems administrator. 
 
Note: You only have to submit the DAT file (e.g. MPP1752.DAT) and not the  

SUPER-AD.LST. 
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3.2 Reporting Payroll Service Events (SUPER-YE) 
 

1. Add the Superannuation Year-end report (SUPER-YE) 
 

a) In the Reports module, double-click the SUPER-YE report in the Report List. 

 

b) Check the report’s Column settings 

Click the Columns tab to make it the active window.  
 

• If your Payroll is still in 2011 and you are checking the 2011 BC Pension 
(Superannuation) then the Value in the Report Layout has to show AMCUYR or 
INCUYR (CUYR indicates current year). 

 

 
 

• If your Payroll is in 2012 and you’re doing the 2011 BC Pension 
(Superannuation) then the Value has to show AMLAYR or INLAYR (LAYR 
indicates last year). You have to change all lines to say either AMLAYR or 
INLAYR. 

 
Hint: To change the Value column, click the Update… button, and double-

click on the line to be changed.  Click the drop-down list box in Item 
Value: to select AMCUYR (or AMLAYR) and click OK. 
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c) Check the report’s Filter settings 
 
Click the Filter tab to make it the active window. 
If the Columns tab has AMCUYR and INCUYR, then the Test Criteria in the Filter 
tab has to have AMCUYR (not AMLAYR) in Value as well.  Click the Update… 
button in Test Criteria to update the Value if necessary. 
 

 
 

Hint: You may want to create two SUPER-YE reports: Current and Last with the 
correct Value column and Filter settings respectively to save the trouble of 
changing CU to LA or vice versa. 

 
d) Print and review the report  

From the Process menu, click Print Reports… and select Current in Records to print 
the current SUPER-YE report.  You can also select Preview Report from the Process 
menu to view it on screen before printing a hard copy.  Review the report carefully, and 
make any necessary adjustments in Payroll. 

 
2. Export the SUPER-YE Report 

 
a) From the Process menu, select Export Reports… 
b) Under Records, select Current. 
c) Press OK to export the report. 
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3. Start the ComVida BC Pension (Superann) Extract program. 
From the Tools menu in Payroll or Reports, select BC Pension Extract.  Sign on with 
the Operator ID and Password used in Payroll or Reports. 

 
4. Import the SUPER-YE file.  

From the Process menu, select Import, and then Contributions… 
 

 
 

a) Enter the name of the report to be imported (SUPER-YE.LST is the 
default name) in Import File:  or click on the Browse… button to select the 
Import file. 

 
b) Update the Employer Name: if necessary. 
 
c) Enter the Employer Number (Employer Organization ID) as assigned by 

the BC Pension Corporation. 
 
d) Update the T4 Year: if required. 
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e) Enter the Union Codes from Payroll, e.g. “H”, “N”, etc. and the 
corresponding FTE Hrs/Year, and map each one to the appropriate Plan, 
and Employee Group.  Don’t forget to do mapping for those non-union 
employees (who may have a blank union code in Payroll) that have to be 
included in the BC Pension Extract Utility program. 

 

If no Effective date is entered, the program will assume the hours entered in 
Hrs/Year apply to the entire year, and you can leave the Effective Date blank. 
 
Note:  You must check the one letter Union code used in Employee Master in 
Payroll.  You may be using “B” or “N” for BCNU, etc.  If no Hrs/Year is entered, 
the program will default the hours to 1950.00. 
 
Tip:  To start over with a fresh import, you can respond Yes if prompted to 
“Erase existing records?”. 
 

5. Verify the Detail List and make changes as required.  

 
 

Update the entries, if necessary, by selecting the line(s), and clicking Update… 
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Warning: Any changes made in the BC Pension Extract (Superann) program will NOT 
be reflected in Payroll.  We recommend correcting the data in Payroll and 
repeating steps 1 to 4. 

 

6. Print the BC Pension Corporation Contributors Report. 

 
a) From the File menu, click Print… to print the records, and make sure the 

Contribution List is selected in the Format section. 
b) Check the report.  If updates are required, refer to step 5 above for any 

necessary corrections. 

7. Export the BC Pension (Superannuation) Contributors Report. 

From the Process menu, click Export, and select Contributions… 
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• Export File: is defaulted to MPP-YE.DAT, the file name required by BC Pension 
Corporation. 

 
• Update the Employer Name: if necessary. 
 
• Update the Employer Number (or Employer Organization ID) as assigned by the 

BC Pension Corporation. 
 

• Update the T4 Year: if required. 
 

Select the appropriate Flags option, if necessary.  It is defaulted to Not Flagged. 
 
A “BC PENSION CORPORATION CONTRIBUTOR MUNICIPAL 
SUPERANNUATION FUND” report will be printed, and you will see a prompt indicating 
“Export was successful!”. 
 
The entries will then be exported to the file specified above (e.g. MPP-YE.DAT).  The BC 
Pension Extract Utility program will put the exported file into the Payroll data folder (i.e. 
\HR\PR1 or \HR\DATA). 

 

8. To submit the file, follow the instructions provided by BC Pension Corporation or your 
systems administrator.   
 
Note: You only have to submit MPP-YE.DAT and not SUPER-YE.LST. 
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4 Setup and shortcuts 

To setup the shortcut, open explorer and migrate to the HR folder where your payroll 
is. 
Find the file titled HRSA32.EXE and right click on it and select Create Shortcut 

 

 

 

F: drive is the drive that the system is found on.  Check your payroll shortcut to 
confirm the drive your payroll is on. 
 


